
FlexReports 
Test Results Management PC Software

User’s Guide

Test & InspectionTest & Inspection

www.AFLglobal.com  |  +1 (800) 235-3423



1

Contents

General Information ............................................................................................ 4

Introduction.................................................................................................... 4

FlexReports Supported Test Sets .................................................................. 4

Basic and Advanced Software Comparison.................................................. 4

Contacting Customer Service........................................................................ 4

System Requirements..................................................................................... 5

Installing FlexReports..................................................................................... 5

Starting FlexReports....................................................................................... 5

Activating FlexReports License...................................................................... 6

Selecting the Application Language............................................................. 8

Files Transfer to FlexReports................................................................................ 9

Transferring Files Wirelessly via FlexApp to FlexReports............................. 9

From USB Flash Drive to PC.......................................................................... 10

Uploading Inspection Results ..................................................................... 10

FlexReports Home Screen.................................................................................. 11

Home Screen Menu Bar............................................................................... 12

File Menu................................................................................................... 12

Edit Menu.................................................................................................. 12

To Configure General Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            12

Help Menu................................................................................................. 13

About FlexReports screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  13

Results / Reports Application............................................................................ 14

Generating Reports with FlexReports and Legacy Report Wizard........... 14

To Generate Reports Using FlexReports Functionality.............................. 15

Navigating Reports generated with FlexReports................................... 16

To Generate Reports Using Legacy Report Wizard Functionality............. 17

Creating Bidirectional OTDR Reports...................................................... 18

Macrobend/Microbend information In OTDR reports ........................... 18

Creating Single Inspection-only Reports................................................. 18

Creating MPO Inspection-only Reports . . . . . . . . . . . . . . . . . . . . . . . .                       18

Creating OTDR/OLTS with Inspection Reports........................................ 19

OTDR Trace Viewer - Overview......................................................................... 20

Opening Test Results with OTDR Trace Viewer.......................................... 20

Overview of Trace Viewer Interface............................................................ 21

Trace Viewer Menu Bar................................................................................ 22

File Menu................................................................................................... 22

How To Restore Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      23

Edit Menu.................................................................................................. 23

To Edit File Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    23

To Configure Trace Viewer Preferences . . . . . . . . . . . . . . . . . . . . . . . .                       24

Tools Menu................................................................................................ 24

Events Menu.............................................................................................. 25

View Menu................................................................................................ 25

©2022,  AFL, all rights reserved.  RPTS-00-1000  Revision AA  2022-07-20 
Specifications are subject to change without notice.



2

Toolbar.......................................................................................................... 26

Trace Graph Window.................................................................................... 27

Event Table.................................................................................................... 28

Event Types................................................................................................ 29

Bidirectional Analysis................................................................................... 29

Macrobend/Microbend Analysis ................................................................. 29

Working with OTDR Trace Files.........................................................................30

Opening Trace Files......................................................................................30

Single-Wavelength or Multi-Wavelength................................................30

To Select a Single-Wavelength Trace Option.......................................... 30

To Select a Multi-Wavelength Trace Option............................................30

To Open a Trace from the Results Explorer............................................. 31

Opening Previous or Next Traces from the Toolbar................................ 32

Comparing Traces with a Baseline Trace..................................................... 32

Closing Files with Changes........................................................................... 32

Moving Cursors and Zooming..................................................................... 33

Selecting the Active Cursor...................................................................... 33

Moving the Active Cursor......................................................................... 33

Zoom In and Out of a Trace...................................................................... 33

OTDR Trace Events .......................................................................................34

Adding Auto Events..................................................................................34

Manual Events........................................................................................... 35

Selecting Loss Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     35

Positioning Cursors Correctly  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               35

Two Point Loss Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    35

Single Event Loss Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  36

Multiple Event Loss Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                36

Fiber Attenuation Loss Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              37

Start Loss Method (No Launch Cable) . . . . . . . . . . . . . . . . . . . . . . . . .                         37

End Loss Method (No Receive Cable) . . . . . . . . . . . . . . . . . . . . . . . . . .                         37

Adjusting LSA Lines...................................................................................38

Adding Manual Events ............................................................................. 39

Editing Event Comments........................................................................... 39

Deleting Events......................................................................................... 39

Restoring a Deleted Event........................................................................ 39

Set/Adjust Pass/Fail Thresholds.................................................................40

Thresholds Allowed Limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  40

Editing Event Pass/Fail Limits  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               40

Editing Information of a Single Trace......................................................... 41

Printing a Single Report............................................................................... 42

OTDR Trace Batch Editor Application................................................................43

Trace Batch Editor Screen Features.............................................................44

Menu Bar....................................................................................................... 45

File Menu................................................................................................... 45



3

Edit Menu.................................................................................................. 45

Tools Menu................................................................................................ 45

Help Menu................................................................................................. 45

Toolbar.......................................................................................................... 45

Auto Events Editor........................................................................................46

Adjust Pass/Fail Editor.................................................................................. 47

Thresholds Allowed Limits........................................................................ 47

Edit & Reapply Event Pass/Fail Limits . . . . . . . . . . . . . . . . . . . . . . . . . .                          48

Cursor Editor................................................................................................. 49

Trace Information Editor.............................................................................. 50

OLTS Viewer/Editor Application........................................................................ 52

Opening Test Results with OLTS Viewer/Editor.......................................... 52

OLTS Viewer/Editor Screen Features........................................................... 53

Menu Bar.......................................................................................................54

File Menu...................................................................................................54

To Restore Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          54

Edit Menu..................................................................................................54

Edit Fiber Under Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      54

Edit or Create New User Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               55

To Configure General Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            55

Tools Menu................................................................................................ 55

Help Menu................................................................................................. 55

About FlexReports screen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  55

Toolbar.......................................................................................................... 55

Viewing OPM Results in the OLTS Viewer/Editor....................................... 56

To Select Standards and Applications...................................................... 56



4

General Information 

Introduction
FlexReporter Software Suite works with AFL Test and Inspection instruments to provide a simple-to-use, high 
performance cloud enabled reporting platform. FlexReporter combines FlexApp – a mobile App that wirelessly 
transfer test results to FlexReporter-Cloud from the field with a fast, comprehensive, 3-step reporting solution 
– FlexReports PC software. The FlexReporter software suite was developed to make the complicated task of 
reporting faster, simpler, and easy-to-use. 

FlexReports is a Windows®-compatible PC software that provides comprehensive test results analysis and reporting 
for AFL FlexScan OTDRs, FOCIS inspection systems, OLTS, and OPM products. It is available in both Basic and 
Advanced versions. 

FlexReports Basic software version enables users to quickly view and analyze results. It allows users to generate 
simple single-fiber OTDR and OLTS reports and includes a 60-day Advanced software and OTDR Trace Batch Editor 
license trial. 

FlexReports Advanced is a full featured reporting and post-processing solution for generation of professional 
acceptance reports using Industry Standards. It enables users to generate reports showing dual-wavelength traces 
and event tables, end-face image, event map and loss data for each fiber. Users can apply Pass/Fail thresholds to 
OTDR events and OLTS measurements, and create and apply application rules per Industry Standards. FlexReports 
OTDR Trace Batch Editor enables users to edit and analyze multiple trace files simultaneously.

FlexApp is a mobile Android and iOS App that supports AFL’s FlexScan® OTDRs and FOCIS connector inspection 
products (FOCIS Flex, FOCIS Lightning). FlexApp wirelessly transfers test results from any FlexScan OTDR or FOCIS 
inspection probe directly to FlexReporter-Cloud from the field for subsequent analysis, editing, and reports 
generation with FlexReports PC software.

FlexReports Supported Test Sets 
	• FlexScan FS200 OTDR; FlexScan FS300 OTDR. FlexScan TS100 Troubleshooter 

	• FOCIS Flex Inspection Probe, FOCIS Lightning Inspection Probe

	• ROGUE OLTS Certifier

Basic and Advanced Software Comparison
The table below provides a summary of the software licensing features. 

FlexReports Features Basic License Advanced License
OTDR Trace Viewer, OLTS Viewer/Editor
OTDR Trace Analysis with Bidirectional and Macrobend analysis
OTDR Add/Delete events from the Trace Viewer
Single Fiber reporting for OTDR and OLTS results 
.SOR file to .CSV file export 
60-Day Reporting and Batch Editor License Trial
Download of test results stored in the FlexReporter cloud
Reports Wizard, compatible with TRM
3-step reporting using new fast FlexReporter cloud report service
Hyperlinked PDF test reports with clear Pass/Fail indicators
Batch editing of OTDR .SOR files for renaming results, correcting 
Pass/Fail limits and launch cable settings

Contacting Customer Service
If you have any questions about your AFL test and inspection equipment or FlexReports software, or if you need 
technical or sales support, please contact Customer Service. You may contact Customer Service between 8 a.m. and 
5 p.m., United States Eastern Time, as follows:

Phone:	 +1 (800) 235-3423 

Web:	 www.AFLglobal.com

E-mail:	 AFLtesttechsupport@AFLglobal.com

General Information

http://www.AFLglobal.com
mailto:AFLtesttechsupport%40AFLglobal.com?subject=
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System Requirements
To use FlexReports application, you need the following hardware and software:

	• A PC with a i7 processor, 64-bit architecture, Quad core @ 2.6G Hz (or faster) processor and an 800 x 600 (or 
larger) display and USB 2.0 port

	• At least 16 GB of CPU memory and 9GB available memory

	• Note: slower processors and smaller RAM may affect report generation time, and maximum report Job size

	• Windows compatible pointing device (e.g. mouse)

	• MS Windows 10. Note that MS Windows 7 is no longer actively supported

	• A network connection if downloading and installing from www.AFLglobal.com

Installing FlexReports
You can install FlexReports from the supplied USB memory stick, or you can download it from our web site at 
https://www.aflglobal.com/Resources/Software.aspx.

Follow the steps below to install the FlexReports software.

1.	 Start Windows. If Windows is running, quit all applications.

To install from USB:

2.	 Insert the FlexReports USB memory stick into a USB port.

3.	 Double-click the My Computer icon on the desktop to open the My computer folder.

4.	 Double-click the USB drive icon.

5.	 Open the FlexReports_v1.n.n Install folder.

6.	 Continue with step 11.

To download from the web:

7.	 From https://www.aflglobal.com/Resources/Software.aspx, select FlexReports Software and click on download 
link.

8.	 Follow the on-screen instructions. FlexReports software will download to your computer’s hard drive.

9.	 Open FlexReports_v1.n.n Installl.zip and extract all contents to FlexReports_v1.n.n Install folder.

10.	Open FlexReports_v1.n.n Install folder.

11.	If you wish to complete an unattended install of FlexReports to C:\Program Files (x86)\AFL\FlexReports, 
double-click on InstallFlexReports_unattended.bat. FlexReports installation will proceed, display progress, and 
complete with no user response required and you may skip steps 12-14.

12.	If you wish to select the destination folder for FlexReports software, double-click on 
InstallFlexReports_configured.bat and select ‘Yes’ when prompted to allow changes to your computer.

13.	When the Installer ‘Welcome’ screen is displayed, click on the ‘Next’ button to continue.

14.	When the Installer displays the ‘Installation Complete’ screen, click ‘Close’.

Starting FlexReports
Follow the steps below to start the FlexReports application: 

1.	 Depending on your Windows OS version, navigate to a list of the installed Program. Locate the AFL folder.

2.	 Click on the FlexReports shortcut If you have installed the FlexReports application in a folder other than AFL 
Test and Inspection, choose that folder from the Start > Programs menu.

3.	 When FlexReports is first launched, you may choose to install sample test data for generating sample reports.

4.	 If you are presented with the option to update to a newer version, click ‘Install Updates’ button.

General Information

http://www.AFLglobal.com
https://www.aflglobal.com/Resources/Software.aspx
https://www.aflglobal.com/Resources/Software.aspx
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Activating FlexReports License
1.	 At the Activation Wizard screen, select one of the following option:

	• Activate FlexReports Online option to activate purchased license with activation code provided by AFL .

	• Begin a FlexReports Advanced free trial.

	• Click Next to continue.

2.	 At the “End-user License Agreement” screen perform the following:

	• Read the End-user License Agreement.
	• Check “I accept...” box to agree.
	• Click Next to continue.

3.	 At the “License Information” screen, enter the required information. Click Next to continue.

4.	 If Activation displays “Proxy Error” screen, click OK and then click Proxy Settings.

5.	 At the Proxy Settings sub-screen, enter the required information and click OK to continue.

General Information

1

4

2 3

The Server field is in the form of “server:port” e.g. 
“proxy.myco.com: 3128”

5
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6.	 Activation will display progress.

7.	 When Activation Complete screen is displayed, click Finish to finalize.

8.	 Next, you will see the FlexReports Home screen.

General Information

FlexReports Advanced LicenseFlexReports Advanced Free Trial

Note: 

The FlexReports License Information and/or the Trial Expiration date (if a 60-day Evaluation is activated) is available 
and accessible form the FlexReports Help menu.

	• At the Home screen, select Help.

	• From the Help menu, click License Information to display the information sub-screen.

6 7 8
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General Information

3.	 On the Preferences screen, select the desired language from a list of available Program languages and a list of 
available Report languages.

4.	 When done, click OK. 

5.	 Next, you will see the Warning screen; click Yes to confirm the application restart.

6.	 FlexReports will restart in the selected language.

Selecting the Application Language
1.	 From the Home screen menu bar, select Edit.

2.	 From the Edit menu, click Preferences.

4

5

2

3
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Using FlexReports for Downloading Test Results from FlexReporter-Cloud

1.	 From FlexReports Home screen menu, click File and click “Log in to FlexReporter-Cloud” to log in.

2.	 Click “Download data from FlexReporter-Cloud. Navigate and select the desired folder with results for 
download, then click “Download”

3.	 Return to the FlexReports Home Menu to view results or generate a test report.

Files Transfer to FlexReports

Transferring Files Wirelessly via FlexApp to FlexReports
Use the FlexApp to wirelessly transfer test results to FlexReports PC-based software to make report generation 
quick and easy.

1.	 From the AFL test equipment (FlexScan or FOCIS), locate and select test results that you’d like to transfer.

2.	 Use FlexApp:

	• From Google Play or App Store, download FlexScan App to your mobile device.

	• Create cloud account from within FlexApp.

	• Using FlexScan / FOCIS Bluetooth functionality, initiate transferring the selected test results to FlexApp.

	• Observe how FlexApp forwards test result files to FlexReporter cloud.

3.	 Use FlexReports to download test results from FlexReports cloud and create your test reports.

Files Transfer

1 2 3

1 2
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From USB Flash Drive to PC
To transfer files from your test equipment to a PC using the USB drive, perform the following: 

1.	 Copy any files stored on your test equipment Internal Drive to the USB drive. 

2.	 Remove the USB drive from your test equipment and plug it into the USB port on your PC.

3.	 Copy files from the USB Flash drive to your PC.

Uploading Inspection Results 

From FOCIS Flex, FOCIS Lightning Connector Inspection Probes

1.	 Connect FOCIS probe to PC using micro-USB to USB cable.

2.	 Turn on FOCIS probe. Note: Screen will remain dark.

3.	 At PC, double-click on My Computer and verify that PROBE (E:) is displayed.

4.	 Probe’s drive letter may be different.

5.	 Open Results folder in PROBE (E:) to view saved Job folders.

6.	 Drag desired folders or files to desired PC location (e.g. My Documents, etc.).

7.	 If merging FOCIS files with FlexScan OTDR files:

	• Verify files have same End1-End2-Cable prefix.

	• Verify inspection fiber #s match OTDR fiber #s.

	• If filenames OK, copy or drag the files into corresponding OTDR results folder.

Files Transfer
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Files Transfer

Ref Features / Application Function
 1 Menu Bar This field contains menus that are available in FlexReports

 2 Login Icon Indicates User Login Status to FlexReporter-Cloud
 - Logged to FlexReporter-Cloud
 - Not Logged to FlexReporter-Cloud

 3 Cloud Icon Indicates Status of Cloud Connection and the Cloud icon indicates connection 
states to FlexReporter-Cloud

 - Connected
 - Disconnected

 4 Results / Reports Results - This application provides a brief preview of selected results within the 
Results Explorer screen. Use this application to navigate test results and view OTDR 
and Loss Test results.
Reports - Use FlexReports (cloud service) or Report Wizard to generate test reports 
for the selected data. Select from pre-defined report configurations. 
Print generated test reports or store them as PDF files.

 5 OTDR Trace Viewer Use the OTDR Trace Viewer to view and analyze OTDR traces and edit single fiber 
single direction traces.

 6 OTDR Trace Batch Editor This application allows multiple trace files to be edited simultaneously. Recalculate 
events, apply common pass/fail rules, and/or prepare reports using a group of 
OTDR results files.

 7 OLTS Viewer/Editor Use this application to view loss/power measurements. View certification results 
and select cabling standards, user rules and applications to be applied as Pass / Fail 
limits to certification results.

FlexReports Home Screen
Home screen is the first screen you will see on FlexReports power-up. This screen contains shortcuts to FlexReports 
Applications, Menus, and Cloud login.

4

1

5

2 3

6 7
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Home Screen Menu Bar
The Home screen Menu bar contains File, Edit, Tools, Events, and Help menus. 

File Menu

Table below gives a summary of the available File Menu commands and their associated functions.

Command Use to perform the following Function
Open... Access the Results Explorer, navigate and open test results.
Login to FlexReporter-Cloud /
Logout of FlexReporter-Cloud

Login to FlexReporter Cloud / Logout of FlexReporter Cloud

Reset FlexReporter-Cloud Password Reset FlexReporter Cloud Password
Change Organization... This menu option allows changing to another organization (if applicable)

Download data from FlexReporter-
Cloud...

Access FlexReporter Cloud Wizard to download 

Import Results... Download test data from an instrument.
Import OFL Results... Download test data from an OFL250 or OFL280 (non-FlexTester).

Export Job to File... Export the selected Job to a zip file.
Backup Data... To have a restoration point, create a non-visible backup copy of your data 

before editing:
	• Navigate the desired Job /Route/Cable
	• Click OK to display the Backup Description window
	• Add a clear comment on backed up data to be able to identify it during 
restoration

Restore Data... Restore previously backed up data to a visible folder. Use comments to 
identify data for restoration.

Exit Close opened trace files and exit FlexReports.

Edit Menu

When accessed from the Home screen, Edit menu allows the user to configure General Preferences.

To Configure General Preferences

To Configure Preferences: set Trace distance units, select Language, select preferences for saving User Rules, and 
set preferences for collecting Analytics data.

Files Transfer
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Help Menu

This menu provides access to the following: AFL web site, AFL Test and Inspection web site, AFL Software updates 
on the web, License Information, “About FlexReports” screen.

About FlexReports screen

About FlexReports screen displays FlexReports version number, allows to see included Modules/Versions, and 
enables the user to collect the Error Log data.

1.	 When in the About FlexReports screen, click on the Details button display the “FlexReports About Details” 
screen.

2.	 Click on the “Technical Support” button to display a sub-screen that allows packaging the Error Log data.

3.	 Clicking on “Prepare Information” will package the Error Log data into zip folder that can be send to AFL 
Technical Support as an attachment.

Files Transfer

FlexReports Advanced License in this exampleFlexReports 30-day Trial in this example

1 3

2
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Use this application to navigate test results, switch between OTDR and OLTS test viewers (when applicable), and 
access FlexReports (cloud) or legacy Report Wizard.

The table below gives a summary of the Results Explorer / Reports Generator features.

# Feature Description
 1 File explorer Displays folders and files hierarchy. Use to navigate saved test results.
 2 Results window Depending on the selected data on the “File Tree”, the Results window will display 

various information as follows:
	• Path of the currently selected folder
	• Summary of the selected Job/Route/Cable/Fiber
	• Test result preview: OTDR thumbnail, OPM result, Certification result

 3 Zoom buttons Click to zoom in, zoom out, and reset pages back to their default value.
 4 Viewer button Depending on the selected test result, this button alternates between Trace Viewer 

and OLTS.
Click to view the selected result in OTDR Viewer / OLTS Viewer.

 5 FlexReports button Click this button to configure OTDR reports easily with FlexReports (inspection and 
OLTS Reports generation with FlexReports coming soon).

 6 Report Wizard 
button

Click on this button to access the Report Wizard, which enables generation of test 
reports and selection of pre-defined report templates and cover sheets.

 7 Cancel button Click on this button to return to the Home screen.

Results / Reports Application

Results / Reports Application

Generating Reports with FlexReports and Legacy Report Wizard
Results / Reports Application offers a simplified reporting combining test Results viewer and Reports generator on 
a single screen.

There are two report options available for users to choose from:

	• FlexReports - Simple 3-step configuration reporting option. FlexReports uses Flexreporter-Cloud report service 
for large projects and fast reporting.

   Note: Currently only OTDR reports are supported – coming soon are Inspection & OLTS reports.

	• Report Wizard - Support legacy Report Wizard functionality for Inspection and OLTS reports.

Results / Reports application is accessed from the Home screen by pressing the Results / Reports icon. 

3

6

5

4

7

1

2
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Results / Reports Application

To Generate Reports Using FlexReports Functionality
1.	 From the Results / Reports main scree, access FlexReports by clicking the FlexReports button.

2.	 You will briefly see the “Launching FlexReports...” notification. 

3.	 When Configure Report screen is displayed, configure reports data as desired: set-up project name; select test 
results to include; select report sections to include.

4.	 Click Create.

5.	 Next, you will see “Generating Report” progress status.

6.	 Next, you will see generated Report. Refer to the next section on details how to navigate reports.

1 4

3

5

2

6
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Results / Reports Application

Navigating Reports generated with FlexReports

1.	 Project Summary page - Displays summarized Report Summary, clear Pass/Fail Summary, and Fiber Groups 
Summary.

2.	 Fiber Group /Cable page - Displays compact Fiber Group report with Link Metric.

3.	 Fiber Details page - Displays detailed test results of a fiber with LinkMap® and Event Table.

Note: Fiber Groups and Fiber Numbers are hyperlinked for easy navigation.

Project Summary page Fiber Group / Cable page Fiber Details page
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To Generate Reports Using Legacy Report Wizard Functionality
The Report Wizard application provides the user with a variety of pre-defined report templates and cover sheets 
and allows generating professional test reports that may be printed or stored as PDF files. Features of the Report 
Wizard are:

	• Template-based wizard provides quick setup with professional report generation.

	• Common reports information may be saved for use in future reports (faster report generation).

	• Customer Info, Preparer info, Consultant info, etc.

	• Select from available templates to quickly generate professional, consistent reports.

	• Include or omit any page: Cover, Report Summary, Route Summary, Cable Summary.

	• Reports for OTDR result.s 

	• Reports for OLTS results.

	• Reports for combined OTDR & OLTS results.

	• Reports for combined OTDR, OLTS, and Inspection end-face image results.

To Create Reports with Legacy Report Wizard

1.	 From the Results / Reports main scree, access Report Wizard by clicking the Report Wizard button.

2.	 Follow the on-screen instructions for generating, saving, and printing test reports.

1

2

Cable Summary: Allows the user to include Thumbnail images of 
the captured end-faces.

Result Detail Pages: These pages allow the user to generate 
dedicated inspection reports or include inspection images with 
OLTS and/or OTDR results.

Results / Reports Application
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Creating Bidirectional OTDR Reports

The Bidirectional OTDR information is part of a report “OTDR Single Graph with Overlay wavelength trace with 
Bidirectional Events”.

Bidirectional OTDR results displayed on the “file tree” as two-trace  icon.

1.	 Acquire and Save Bidirectional OTDR results:

	– Reset Fiber to 001 when testing first fiber in each direction.

	– Make sure  the same test settings (range, pulse width, etc.) are used in both directions.

	– Use the same launch and receive cables in both directions.

	– Make sure the same Job and Cable names used in both units.

	– Swap OTDR End & Far End names when testing from other direction.

	– Results will be saved in two Cable folders within same Job folder in FlexScan.

	– Manually merge OTDR results from 2nd Cable folder into 1st Cable folder.

2.	 Merge Inspection results into OTDR Job/Cable or Job/Route/Cable folder on PC.

3.	 Install and run FlexReports.

4.	 Select Results / Reports > Report Wizard.

5.	 Navigate to merged OTDR/OLTS and Inspection results:

	– Select entire [Cable] for all results.

	– Select individual fiber for single result.

6.	 Select “OTDR Single Graph with Overlay wavelength trace with Bidirectional Events” template.

7.	 Select Finish and print or save as PDF.

Macrobend/Microbend information In OTDR reports 

The Macrobend/Microbend is indicated on all OTDR reports in Event table. 

This includes the following report templates:

	• OTDR Multi-view traces and OLTS table.

	• OTDR Multi-view traces with Images and OLTS table.

	• OTDR Multi-view traces with Overall Pass/Fail, Event Map and Complete OLTS table.

	• OTDR Multi-view traces NO Pass/Fail, Event Map and Complete OLTS table.

	• OTDR Single Graph with Overlay wavelength traces.

Creating Single Inspection-only Reports

Test results with fiber end-face inspection images are saved in .JPG, .GIF, or .PNG file format and displayed on the 

“file tree” as fiber end-face  icon.

1.	 Navigate to the uploaded Inspection results:

	– Select entire [Cable] for all results.

	– Select individual fiber for single result.

2.	 Select the desired inspection template (2 or 12 results per page).

1.	 Select Finish and print or save as PDF.

Creating MPO Inspection-only Reports

1.	 Navigate to the uploaded Inspection results:

	– Select Route folder(s) for all results.

	– Select Cable for cable results .

	– Select individual MPO(s) for connector results.

2.	 Select desired inspection template (2 or 12 results per page).

3.	 Select Finish and print or save as PDF.

Results / Reports Application
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Creating OTDR/OLTS with Inspection Reports

1.	 Navigate to merged OTDR/OLTS & Inspection results:

	– Select the entire [Cable] for all results.

	– Select the individual fiber for a single result.

2.	 Select desired OTDR/OLTS template.

3.	 Select Finish and print or save as PDF.

Results / Reports Application
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OTDR Trace Viewer

OTDR Trace Viewer - Overview
Within the OTDR Trace Viewer users can analyze .sor formatted trace files from AFL FlexScans. FlesReports allows 
users to apply new automatic bidirectional analysis and macrobend detection capabilities for all AFL OTDRs. Users 
can apply pass/fail thresholds to events and links, add/delete events, change loss methods including two point, LSA 
and fibre attenuation. Next and Previous buttons allow quick review of fibre results.

Opening Test Results with OTDR Trace Viewer
This application may be accessed in several ways:

1.	 From the Home screen, click on the OTDR Trace Viewer icon.

2.	 From the Home Screen, click File / Open to display FlexReports Results Explorer:

	– Select the desired fiber and with this fiber selected, double-click on a trace icon.

	– Or, Select the desired fiber and with this fiber selected, click on the Trace Viewer button.

Use the OTDR Trace Viewer to analyze OTDR traces and edit single fiber single direction results.

1

2
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OTDR Trace Viewer

Ref Feature Description
 1 Menu bar Displays the available drop down menus.
 2 Toolbar Contains several icons for quick access to menu commands.

Click on an icon to execute the associated command.
 3 Applications tabs Click on a tab to display the corresponding application window.
 4 Results button “On mouse over” the Results button, the Results window is displayed and “on mouse 

out” the Results window is auto-hidden.
 5 Results window The Results window displays folders and files hierarchy and is used to navigate saved 

test results. To disable/enable the “auto hide” functionality, click the Auto Hide icon 

 located in the right top corner of the Results window.
 6 Job Info window Contains informative fields: Job/Route/Cable name, fiber number and direction.
 7 Full trace Reference 

view
Shows the current trace view relative to the entire trace.

 8 Cursors data This field displays the following information: A and B cursor locations, distance from A 
to B, selected loss method, and (depending on the selected loss method) insertion loss, 
reflectance, or fiber attenuation.

 9 Trace graph 
window

Shows a graph of the currently selected trace. Up to six traces can be displayed in the 
Trace graph window.

 10 Event Table Displays saved events in a table format.
 11 Trace Info/Text 

Info/Unit Info field
This field displays OTDR setup parameters or Text data or Test equipment data when 
the associated tab Trace Info/Text Info/Unit Info is selected.

 12 Edit Trace Info 
button

Click on this button to display the Edit Trace Information window, which allows editing 
of the Trace and Text info for the selected trace file.

Overview of Trace Viewer Interface
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Trace Viewer Menu Bar
The Menu Bar contains File, Edit, Tools, Events, View, and Help menus. When a menu is selected, it displays a list of 
commands indicating functions that can be performed on selected files.

File Menu

Table below gives a summary of the available File Menu commands and their associated functions.

Command Use to perform the following Function
Open... Access the Results Explorer. Depending on the user preference setting (Edit 

>Preferences > Single-Wavelength or Multi-Wavelength), open a single 
trace file or a multiple trace file.

Open as Baseline... Access the Results Explorer. 
Depending on the on the user preference setting (Single-Wavelength or 
Multi-Wavelength), open a single trace/multiple trace file as a baseline.
Note: a baseline trace is a trace graph that is used as a point of reference for 
comparison.

Save Save a trace file that already exists with its original name. 
Save As... Save an existing trace file under a new name and preserve the original file 

and/or to save the file in a different format (SOR v1 or SOR v2).
Convert Convert SOR Version 1.0 files into SOR Version 2.0 file format.

Close Depending on the selected option for closing files, close selected files after 
automatically saving changes, or prompt the user to confirm saving.

Close All Close all open trace & baseline files.

Login to FlexReporter-Cloud /
Logout of FlexReporter-Cloud

Login to FlexReporter Cloud / Logout of FlexReporter Cloud

Reset FlexReporter-Cloud Password Reset FlexReporter Cloud Password
Change Organization... This menu option allows changing to another organization (if applicable)

Download data from FlexReporter-
Cloud...

Access FlexReporter Cloud Wizard to download 

Import Results... Download test data from an instrument.
Import OFL Results... Download test data from an OFL250 or OFL280 (non-FlexTester).

Export Job to File... Export the selected Job to a zip file.
Backup Data... To have a restoration point, create a non-visible backup copy of your data 

before editing:
	• Navigate the desired Job /Route/Cable
	• Click OK to display the Backup Description window
	• Add a clear comment on backed up data to be able to identify it during 
restoration

Restore Data... Restore previously backed up data to a visible folder. Use comments to 
identify data for restoration.

Exit Close opened trace files and exit FlexReports.

OTDR Trace Viewer
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Edit Menu

The Edit menu allows the user to edit File Information and configure Trace Viewer Preferences.

To Edit File Information

OTDR Trace Viewer

How To Restore Data

1.	 From the File Menu, Click Restore Data and perform the following:

	• You may click on individual Backups to review comments saved during the Backup Data process. Using these 
comments, identify and select data for restoration.

	• Or, you ,ay select the “Restore Entire Archive” option.

	• Click OK.

2.	 In the displayed File Navigator window, select the desired location and then click OK to save the restored data.

1 2

These text fields allow the user to view test settings 
and edit some test parameters (Date, GIR, Backscatter 
Coefficient, and Reflectance Threshold). Changing GIR 
or Backscatter Coefficient will cause recalculation of 
the Event Table and fiber length.

These are the text editable fields, which allow the 
user to edit Cable Type, Operators ID, or Company 
name and add Trace Comments.
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Tools Menu

The Tools menu provides access to the same Applications as the Home screen.

OTDR Trace Viewer

To Configure Trace Viewer Preferences

Use the Preferences menu to select the appearance of traces and how they are opened/closed/saved.

Options to open and 
close files

Distance units

Options to save 
changed files

Advanced Visual 
Settings on/off

Options to display 
gridlines in Trace 
Window

These are Event Table Analysis 
(Macrobends/Microbends detection 
and Bidirectional analysis) settings 
on/off settings

Click to reset all 
settings to the factory 
default values

Number of recently 
open files to be 
displayed under File 
menu (allowed 1 to 
99 files)

Color options to 
display traces
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Events Menu

The Events menu contains all the commands you will need to select loss methods, add new events, and review or 
delete saved events. The table below gives a summary of the available Events menu commands and associated 
functions.

Command Use to perform the following Function
Add Event... Add an event using the selected Loss Method at the active cursor location (not 

available for the Two Point or Fiber Attenuation methods). 
Loss Method Select the desired Loss Measurement Method (for details, see page 35).

Current Event:

	– Edit Comment 

	– Delete

Open a dialog box for adding and/or editing comments for the current event. 

Delete the current event.

Next Event Display the next event: moves the active cursor to the next event and highlight 
this event in the event table.

Previous Event Display the previous event: moves the active cursor to the previous event and 
highlight this event in the event table.

Delete All Events Delete all saved events in the selected trace, event table.
Restore Event Restore the last event that was deleted.
Auto Events... Generate an event table.
Set/Adjust Pass/Fail Thresholds... Edit Pass/Fail event and link Thresholds and recalculate events data.
Restore LSA Defaults Restore LSA line lengths to the default values.

View Menu

View drop down menu allows the user to see selections that affect the view of the OTDR trace. Also, the View 
menu displays the available keyboard shortcuts.

OTDR Trace Viewer
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Toolbar
Several of the most commonly used commands can be accessed from the Toolbar. Click on a Toolbar icon to 
execute the associated command. 

Command Function
Open Access the Results Explorer and navigate the desired test results
Save Save a trace file that already exists with its original name
Results/Reports Open the Results/Reports Application
Prev File Open the previous file in the current folder
Next File Open the next file in the current folder
Horiz Zoom (+) Zoom in horizontally around the active cursor
Horiz Zoom (-) Zoom out horizontally around the active cursor
Vert Zoom (+) Zoom in vertically from the trace level at the active cursor
Vert Zoom (-) Zoom out vertically from the trace level at the active cursor
UnZoom Display the trace view at 100%
ReZoom Zoom to the previous zoom level around the active cursor
Prev Event Select the previous event
Next Event Select the next event
Switch Cursor Switch the active cursor

OTDR Trace Viewer
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Trace Graph Window

The Trace graph window displays OTDR test results in a graph format. Up to six traces can be displayed. Major 
features of the Trace graph window are explained below.

# Feature Description
 1 Trace tab Displays the name and color of the open trace. If several traces are open, click on a trace 

tab to display the associated trace graph.
 2 Vertical axis Shows insertion loss in dB.
 3 Horizontal axis Shows distance in user-selected units (km, m, mi, kf, ft).
 4 Trace This is a graph of insertion loss vs. distance.
 5 A and B cursors Used to measure insertion loss, power level, reflectance, attenuation, and distance. To 

make a cursor active, click on the cursor line or label, or click on the Toolbar Cursor icon to 
toggle between A and B cursors.
To move the active cursor, position the mouse pointer on a cursor, then click-and-drag 
along the trace graph. Also, you may use the Left and Right keyboard arrow keys.

 6 Cursor label To move the active cursor, position the mouse pointer on a cursor or a cursor label, then 
click-and-drag along the trace graph.

 7 Event mark Indicates the location and the number of a saved event. Events are listed in numerical 
order.

 8 LSA lines Available for certain loss measurement methods. Used for calculating insertion loss, trace 
level, and attenuation. 

 9 LSA line 
boundaries

Near and Far LSA line boundaries for each LSA line segment. Used to control length and 
position (relative to trace segment) of LSA line.

 10 Trace end names End names of the displayed trace are shown on the trace graph on each side to make 
directional information clearer.

OTDR Trace Viewer

[B] label indicates a Baseline trace
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Features of the Event table window are explained below.

Ref Feature Description
 1 Summary data Bidirectional analysis summary data is shown in the header as follows:

	• Bidirectional Events data:
	– Number of Events,
	– Maximum Average Splice Loss (non-reflective) between the directions,
	– Maximum Average Connector Loss (reflective) between the directions
	– Max Reflectance between the directions

	• Link Loss data:
	– Link Loss END10000 -> END200, ink Loss END200 -> END10000, 
	– Average Link Loss

	• Link ORL data:
	– Link ORL END10000 -> END200, Link ORL END200 -> END10000 

	• Link Length
 2 Event type icon Indicates the event type graphically. See section “Event Types” on page 29 for details.

 3 Event number Displays the number of the saved event in numerical/position order.

 4 Direction Indicates directions for each event.

 5 Atten.(dB/km) The dB/km measurement is a slope of the fiber leading to the event.

 6 Loss (dB) Shows Insertion loss in (dB) of the fiber segment before the event.

 7 Source This column indicates how the event is added:
	• Manual - added by operator.
	• Auto - event table is generated by OTDR software.

 8 Pass/Fail indicators Indicates Pass -  or Fail -  result for event (Reflectance or Loss). 
 9 Event Type This column describes the event type.

 10 Location Indicates Distance from the OTDR (or end of launch cable) to the event.

 11 Refl. (dB) Displays Reflectance in (dB) for each reflective event. Green highlight indicates Passing, 
Pink highlight indicates Failing.

 12 Loss (dB) Displays Insertion Loss in (dB) for each event. Green highlight indicates Passing, Pink 
highlight indicates Failing.

 13 Cum Loss (dB) Displays Cumulative Loss (event loss plus fiber loss) for the fiber up to the event point in 
each direction.

 14 Avg Loss (dB) Displays Average Loss for the fiber up to the event point in each direction.

Note:  Pass/Fail column will be absent and Reflectance and Loss results will not be color-coded if Pass/Fail analysis 
was not performed in the OTDR. To perform Pass/Fail analysis, select Events menu, select “Set/Adjust Pass/Fail 
Thresholds...”, check the boxes for the thresholds to be applied, edit the threshold if necessary, and press “OK.”

Event Table
The Event table allows the user to view test data associated with the trace displayed in the Trace graph window. If 
several traces are open, click the desired trace Tab located on top of the Trace graph window to display the Event 
table of the desired trace. Using the Events menu, you may add or delete trace events and edit comments.

OTDR Trace Viewer
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Event Types

Icon Event Type Description
Start The start of the fiber under test.

End The end of the fiber under test.

Non-reflective Loss Event An event with measurable loss but very small or unmeasurable reflectance, 
typically caused by a fusion splice, fiber break, or macrobend (with 
macrobend detection disabled).

Non-reflective Gainer Event An event with “negative loss,” which can occur in OTDR traces where two 
fibers with very different backscatter coefficients are spliced or connected. 
A gainer will be seen as a normal (positive loss) event when tested from the 
other end of the fiber. The true loss of the event is approximately equal to 
the average of its loss measured from each end of the fiber under test.

Reflective Event An event with measurable loss and reflectance, typically caused by a 
connection or mechanical splice.

Macrobend/Microband A non-reflective loss event with significantly higher loss at longer 
wavelengths (1550, 1625, 1650 nm) than seen at shorter wavelengths (1310, 
1490 nm). Typically caused by a sharp bend in the fiber.

Splitter PON splitters are detected only when Event thresholds are set to PON 
Default or PON User and a high loss event (> 6 dB) is detected which is 
determined not to be the end of the fiber.

Group Start Event First event in multiple event group. Reports loss of entire group. Reports 
reflectance of first event in group if reflectance of next event can be 
independently measured. Reports max reflectance of grouped events if next 
reflectance cannot be independently measured.

Group Middle Event Grouped events may contain zero, one, or more middle events. Loss of 
middle events is included in group loss reported in the group start event. 
Reports reflectance if it can be independently measured.

Group End Event Last event in a multiple event group. Loss of last event is included in 
group loss reported in group start event. Reports reflectance if it can be 
independently measured.

Bidirectional Analysis
Bidirectional test data for each event is organized in the Event Table by direction and indicated by direction labels 
END100 —> END200 and END200 —> END100. 

Macrobend/Microbend Analysis 
Macrobend detection is the analysis performed to detect and quantify Macrobends and Microbends in a set of 
OTDR traces for a given fiber. This requires OTDR traces taken on the same fiber for at least two wavelengths in a 
single direction. 

Macrobend/Microbend test data for each events is organized in the Event Table and indicated by Macrobend/
Microbend icon and Event type description.

OTDR Trace Viewer
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Working with OTDR Trace Files

Opening Trace Files

Single-Wavelength or Multi-Wavelength

FlexReports offers two options for opening and closing trace files. Depending on the user preference setting 
(Edit >Preferences > Single-Wavelength or Multi-Wavelength), a single-wavelength trace or multi-wavelength 
trace (dual-wavelength/tri-wavelength trace) may be opened and closed within the current folder. For details, see 
section titled Edit Menu > Preferences Dialog Box.

If the Single-Wavelength option is enabled, then trace files will be opened and closed one at a time. If the Multi-
Wavelength option is enabled, then trace files will be opened and closed in wavelength sets (files with the same 
name, fiber number, and fiber type but different wavelengths).

In addition to the open single trace or multi-trace file, the user may open a baseline trace for comparison with the 
current trace/multi-trace. If a tri-wavelength trace and a tri-wavelength baseline trace file are opened, a total of six 
traces will be displayed at one time. 

To Select a Single-Wavelength Trace Option

1.	 From the Edit drop down menu, select Preferences... to display trace settings dialog box.

2.	 Select the Single-Wavelength option, and then click OK. 

To Select a Multi-Wavelength Trace Option

1.	 From the View drop down menu, select the Options command to display the Preferences... dialog box.

2.	 	Select the Multi-Wavelength option, and then click OK. 

OTDR Trace Viewer

Select to open a single trace file

Select to open trace files in wavelength sets



31

To Open a Trace from the Results Explorer

1.	 From the File drop down menu, select the Open click the Open icon on the Toolbar to display the Results 
Explorer.

2.	 From the displayed list, navigate to the desired fiber. 

3.	 To display test results, perform one of the following:

	• If you select on a fiber number, you will see the button labeled Open Viewer with options. Click on Open 
Viewer and select the desired option from the drop down box.

	• If you select on a trace icon, you will see the button labeled Trace Viewer A–>Z or  
Trace Viewer Z–>A. Click on this button to open the selected test result.

OTDR Trace Viewer
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Opening Previous or Next Traces from the Toolbar

After you open a single trace file or multiple trace file, you may use the Prev File and Next File commands to 
display the previous or next trace file or multiple trace file of the same fiber type (MM or SM) in the current folder 
by clicking the Next File or Prev File icon on the Toolbar.

Comparing Traces with a Baseline Trace
FlexReports allows you to open a baseline trace or trace set for comparison to another trace or trace set. If a tri-
wavelength trace and a tri-wavelength baseline trace file are opened, a total of six traces will be displayed at one 
time. 

1.	 From the File drop down menu, select the Open as Baseline option to display the Results Explorer  window. 

2.	 From the displayed list, navigate and open the desired baseline trace (see Section “Opening Trace Files” for 
details).

3.	 From the File drop down menu, select the Open option or click the Open icon on the Toolbar to display the 
Results Explorer  window. 

4.	 From the displayed list, navigate and open the desired trace (see Section “Opening Trace Files” for details).

Closing Files with Changes
Edit > Preferences menu offers two options for closing trace files with changes: 

Save Automatically or Ask “Would you like to save changes?”

Save Automatically option Ask “Would you like to save changes?” option
If a trace file has been edited and not saved, it 
will be saved automatically before closing.

Note: Save Automatically will overwrite an 
existing file.

If a trace file has been edited and not saved, a dialog box will 
appear prompting you to save changes before closing. 

 

To specify how trace files will be closed:

1.	 From the Edit drop down menu, select the Preferences option to display the Preferences dialog box.

2.	 Select the desired option, then click OK.

OTDR Trace Viewer
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Moving Cursors and Zooming
The A and B cursors may be positioned to measure the insertion loss, power level (if applicable), reflectance (if 
applicable), attenuation (if applicable), and distance between any two points on a trace.

To make cursor positioning easier, FlexReports provides tools and commands for viewing different parts of a trace 
graph at various magnifications. Zoom + and Zoom - commands let you magnify or reduce the display of any area 
in the Trace graph window.

FlexReports zooms horizontally around the active cursor and vertically from the trace level at the active cursor.

Selecting the Active Cursor

To make a cursor active, do one of the following:

	• In the Trace graph window, click on the desired cursor line or label.

	• From the Toolbar, click on the Switch Cursor button to toggle between cursors.

Once the active cursor is selected, it can be moved along the trace graph.

Moving the Active Cursor

To move the active cursor, do one of the following:

	• Position the mouse pointer on a cursor line or cursor label, then click-and-drag along the trace graph.

	• Use the Left and Right keyboard arrow keys.

Note: The A cursor cannot be moved beyond the B cursor location, and vice versa.

	• Click on an event in the event table, the active cursor will jump to that event on the trace graph.

Zoom In and Out of a Trace

To magnify or reduce the trace display, use the Toolbar Zoom Buttons as follows:

	• Zoom In or Zoom Out horizontally around the active cursor.

	• Zoom In or Zoom Out vertically from the trace level at the active cursor.

Note: Each click magnifies the view to the next preset percentage until the limit of magnification is reached.

UnZoom and ReZoom the Trace Display

In the zoomed view, FlexReports always displays the active cursor area. The UnZoom and ReZoom commands allow 
you to display different areas of a trace graph at the same level of magnification. If you need to view a different 
point of the trace, move the active cursor, UnZoom and then ReZoom. FlexReports will display the new position of 
the active cursor at the previous zoom level.

Perform the following steps:

1.	 In the Trace graph window, use the Zoom + and Zoom - commands to set the desired level of magnification.

2.	 Click on the UnZoom button to display the trace view at 100%.

3.	 Relocate the active cursor as needed.

4.	 Click on the ReZoom button to display the new cursor location at the previous zoom level.

Note: When you toggle between A and B cursors in the magnified view, the view changes to display area around 
the selected cursor at the same magnification level.

OTDR Trace Viewer
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OTDR Trace Events 

Adding Auto Events

Use the Auto Events command to generate an event table. 

	• Display the Auto Events menu screen by clicking the Auto Events 
located on the menu bar.

	• Review Trace Properties and Event Thresholds.

	• Edit Launch Cable  and/or Receive Cable  as needed.

	• Enable/disable the Advanced Analysis options:

	• Use Bidirectional Information if available.  

	• Detect Macrobends/Microbends.

	• Click OK.

Ref Feature Description
 1 Trace Properties window Contains informative fields. File name, Wavelength, Pulse Width, GIR - Group 

Index of Refraction and Backscatter Coefficient.
 2 Event Thresholds Contains informative fields: Event Loss, Event Reflectance, Event End
 3 Launch Cable drop 

down menu
Displays the available Launch Cable options as follows: 
None, Noyes 150 m, Noyes 500 m, Noyes 1 km, User.

 4 Receive Cable drop 
down menu

Displays the available Receive Cable options as follows: 
None, Noyes 150 m, Noyes 500 m, Noyes 1 km, User.

 5 Use Bidirectional 
information check box

Select/deselect this check box to enable/disable Bidirectional Analysis information 

 6 Detect Macrobends/
Microbends check box

Select/deselect this check box to enable/disable the Macrobends/Microbends 
detection

 7 Defaults check box Select this box to restore default settings for the Trace Editable Properties and 
Event Thresholds

OTDR Trace Viewer
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Manual Events
Selecting Loss Method

For analyzing traces and adding events, FlexReports offers various Loss methods. The following table gives a 
summary of the available methods.

Loss Method Applications Measured parameters # of 
Cursors 

# of LSA 
Lines*

Two Point General purpose Insertion loss between any 2 points of 
a trace

2 0

Single Event Used to analyze connections, 
splices, faults, etc.

Location, Reflectance, Insertion loss of 
any Reflective or Non-Reflective event

1 2

Multiple Event Used if two or more events are 
too close to use other methods

Location and combined Insertion loss 
of multiple events

2 2

Fiber Attenuation Used to measure dB/km of fiber 
between events

Attenuation per km ratio of any 
segment of a trace with no events

2 1

Start Used to set start of fiber level Starting location and level of a trace 1 1
End Used to set end of fiber level. Location, Reflectance, and Trace level 

of the fiber end
1 1

* LSA Line - least squared approximation segment line. Used to reduce the effects of noise and dead zone while 
calculating insertion loss, trace level, and attenuation.

To select the desired Loss method perform the following: 

1.	 From the Menu bar, choose the Events drop down menu.

2.	 Choose the Loss Method command to display a list of the available options.

3.	 Select the desired Loss method.

Positioning Cursors Correctly 

Depending on the selected Loss Method, you will need to position cursors and adjust LSA lines (if applicable) 
properly. The following graphs illustrate position of cursors and LSA lines for the available Loss methods.

Two Point Loss Method

1.	 Position the left cursor at the start of the event.

2.	 Position the right cursor beyond the event where the trace returns to a constant slope.

3.	 Read the insertion loss measurement displayed in the Cursor data window.

OTDR Trace Viewer
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Single Event Loss Method

Position a cursor at the start of the event.

1.	 If required, adjust the right LSA line so the Near Right boundary is located beyond the event where the trace 
returns to a constant slope.

2.	 Read the insertion loss measurement displayed in the Cursor data window. 
Or

3.	 From the Events drop down menu, choose the Add Event to add event manually.

Multiple Event Loss Method

1.	 Position the left cursor at the start of the first event.

2.	 Position the right cursor at the start of the last event.

3.	 If required, adjust the right LSA line so the Near Right boundary is located beyond the event where the trace 
returns to a constant slope.

4.	 Read the insertion loss measurement displayed in the Cursor data window.

Or

5.	 From the Events drop down menu, choose the Add Event command to add event manually.

OTDR Trace Viewer
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Fiber Attenuation Loss Method

This method is used just for analyzing a trace.

1.	 Position left and right cursors on the trace as needed.

2.	 Read the attenuation coefficient (dB/km) measurement displayed in the Cursor data window.

Start Loss Method (No Launch Cable)

Position the left cursor at the beginning of the trace (0 meters).

1.	 If required, adjust the right LSA line so the Near Right boundary is located beyond the reflection where the 
trace returns to a constant slope.

2.	 Read the trace level measurement displayed in the Cursor data window.

3.	 OR, From the Events drop down menu, choose the Add Event command to add event manually.

End Loss Method (No Receive Cable)

1.	 Position the Left cursor at the start of the Far-end reflection.

2.	 If required, adjust the left LSA line.

3.	 Read the trace level measurement displayed in the Cursor data window.

4.	 OR, From the Events drop down menu, choose the Add Event command to save.

OTDR Trace Viewer
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Adjusting LSA Lines

If events of a trace are located very close to each other, you may have to adjust the LSA Lines. The graphs below 
illustrate an example of the LSA lines before and after the adjustment.

To adjust LSA lines, position the mouse pointer over an LSA line boundary, then click and drag to the desired 
location.

Note:  if you need to restore the original lengths of the LSA lines, choose the Restore LSA Defaults command from 
the Events drop down  menu.

OTDR Trace Viewer

LSA Line before the adjustment LSA Line after the adjustment

LSA boundary line



39

Adding Manual Events 

To manually add events, perform the following steps:

1.	 Select the desired Loss method.

Note:  Event type displayed in the Event Table will match the currently selected loss method.

2.	 Move the active cursor to the event to be added.

3.	 From the Events drop down menu, select the Add Event.

4.	 The Add New Event dialog box opens displaying the event data that will be added to the Event table and 
allowing you to add a comment.

5.	 Type a comment in the Comment text field (maximum 94 characters) if needed.

6.	 Click OK to save. FlexReports automatically adds an event data in the Event table window and places an event 
mark in the Trace graph window to indicate the added event.

Editing Event Comments

To edit a comment, do one of the following:

1.	 In the Event Table, select the desired event by clicking on it.

	• From the Events drop down menu, select the Current Event > Edit Comment... command to display the Edit 
Event dialog box.

	• Edit comments as needed.

	• Click on the OK button to save changes.

Or

1.	 In the Event Table, select the desired event by clicking on it.

2.	 Right-click the selected event, to display a submenu.

	• From the displayed submenu, select the Edit Comment... command to display the Edit Event dialog box.

	• Edit comments as needed.

	• Click on the OK button to save changes.

Deleting Events

To delete an event, do one of the following:

1.	 In the Event table, select the desired event by clicking on it.

	• From the Events drop down menu, select the Current Event > Delete or Delete All Events command. 
Or

2.	 In the Event table, select the desired event by clicking on it.

	• Right-click the selected event, to display a submenu.

	• From the displayed submenu, select the Delete Event... command.

Restoring a Deleted Event

From the Events drop down  menu, select the Restore Event command to recover an event that was deleted last.

Note: FlexReports will only restore the last event deleted. All previously deleted events will not be restored.

OTDR Trace Viewer
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Set/Adjust Pass/Fail Thresholds

FlexReports allows the user to edit Pass/Fail event and link Thresholds and recalculate the events data displayed in 
the event table.

1.	 From the Events drop down  menu, select the Set/Adjust Pass/Fail Thresholds... command to open the 
Re-calculate Pass/Fail Thresholds dialog box.

2.	 Edit Event and Link Thresholds to the allowed limits as needed. Click OK. 

3.	 FlexReports will recalculate test results based on the new Thresholds data and display the updated results in the 
Event table window.

Thresholds Allowed Limits

Threshold Min Value (dB) Default Value (dB) Max Value (dB)
Event Pass Thresholds
Loss, Reflective Event 0.05 0.75 3.00
Loss, Non-reflective Event 0.05 0.30 3.00
Reflectance: 1310, 1550 nm -65.0 -35.0 -20.0
Reflectance: 850, 1300 nm -45.0 -22.0 -15.0
Event Marginal Thresholds
Loss, Reflective Event 0.00 0.00 1.00
Reflectance 0.00 -5.00 -10.0
Link Pass Thresholds
Loss: 850, 1300, 1310, 1550 nm 0.00 0.00 35.0
ORL: 850, 1300, 1310, 1550 nm 20.0 25.0 65.0
Link Marginal Thresholds
Loss: 850, 1300, 1310, 1550 nm 0.00 0.00 5.00
ORL: 850, 1300, 1310, 1550 nm 0.00 0.00 10.0

Editing Event Pass/Fail Limits 

When a FlexScan SOR file is opened in FlexReports, pass/fail limits for non-reflective splice and reflective connector 
events are set to the values stored in the SOR file.

The currently set Pass / Fail limits may be viewed and edited for the current results in the Trace Batch Editor by 
selecting Adjust Pass/Fail tab.

1.	 The currently set Pass / Fail limits may be viewed and edited for the current results in the Trace Viewer by 
selecting Events -> Set/Adjust Pass/Fail Thresholds.

2.	 Check (or uncheck) the Event Pass Thresholds to apply (or not).

3.	 Select and edit following event thresholds:

	• Loss, Reflective Event (connector).

	• Loss, Non-Reflective Event (splice).

	• Reflectance.

4.	 Select OK to apply edited pass/fail limits.

Note: FlexReports does not currently support user-edited splitter 
Pass/Fail limits.

OTDR Trace Viewer
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Editing Information of a Single Trace
FlexReports allows you to edit trace information. This is done in the Edit Trace Information dialog box.

1.	 To display the Edit Trace Information dialog box, do one of the following:

	• From the Edit drop down menu, select the Edit File Info.

	• Select the Trace Info tab, and then click on the button.

2.	 In the Edit Trace Information dialog box, edit the desired trace parameters as needed.

3.	 Choose OK to save changes.

Note: Changes are wavelength dependent and apply to the trace indicated by the top tab in the graph window.

OTDR Trace Viewer

These text fields allow the user to view test settings 
and edit some test parameters (Date, GIR, Backscatter 
Coefficient, and Reflectance Threshold). Changing GIR 
or Backscatter Coefficient will cause recalculation of 
the Event Table and fiber length.

These are the text editable fields, which allow the 
user to edit Cable Type, Operators ID, or Company 
name and add Trace Comments.
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Printing a Single Report
1.	 From the File menu, select the Print Trace -> With Overlay / Single / Side by Side command to access the Report 

Preview page.

Depending on the selected printing style, FlexReports allows single or multiple trace view reports as follows:

	• With Overlay style - prints all traces as a single view with overlay wavelength graph and event table for each 
wavelength if available. 

	• Single style - prints single trace and event table for each wavelength if available. If a trace file contains multi-
wavelength test results, a report for each wavelength will be printed on individual pages.

	• Side by Side - prints multi-view traces side by side and event tables if available. 

2.	 From the Report Preview page, click on the Print button. 

3.	 Select the desired printer. 

4.	 Click Print to print a single trace report.

OTDR Trace Viewer
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OTDR Trace Batch Editor Application
OTDR Trace Batch Editor allows users batch process multiple OTDR test results and provides powerful capabilities 
for edits and corrections.

Batch Editing – Benefits

Some benefits of batch editing are:

Easy recovery when technicians:

	• Use default Job names

	• Make Job naming entry errors

	• Misconfigure launch cables

	• Misconfigure pass/fail limits

Enables users to select a group of data files and perform the following edits:

	• Reapply Test settings

	• Adjust Pass / Fail limits

	• Set cursors to same location 

	• Call attention to event (defect) in some but not all fibers

	• Make for consistent professional presentation of results

	• Edit Trace Information:

	• Job, Route, Cable names

	• Test parameters (Pass / Fail limits, launch cables settings

Notes:

	• Users must always be aware of the scope of changes over selected files.

	• FlexReports backs up current settings before making change and provides a recovery path.

OTDR Trace Batch Editor
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Features of the OTDR Trace Batch Editor screen are explained below:

Ref Feature Description
1 Menu bar Displays the available drop down menus
2 Toolbar Contains several icons for quick access to menu commands

Click on an icon to execute the associated command
3 Applications tabs Click on a tab to switch to the corresponding application
4 Directories menu Allows navigation to the desired folder
5 Traces Selector window Displays a list of saved traces in the selected folder
6 Files to Edit window Displays all trace files added to the batch edit list

7 Functional buttons:
Add File Adds the selected trace or multiple traces to the batch edit list 
Add END1-END2 Files Adds to the batch edit list all the traces in the selection showing END100 to 

END200 results
Add END2-END1 Files Adds to the batch edit list all the traces in the selection showing END200 to 

END100 results
Remove File Removes a single trace or multiple traces from the batch edit list
Remove All Files Removes all traces from the batch edit list

8 Trace property editors tabs Click on a tab to activate the corresponding property editor
9 Process Traces button Click on this button to complete and finalize edits

2

4

5

7

3

6

8

9

1

Trace Batch Editor Screen Features
OTDR Trace Batch Editor is accessed from the Home screen by clicking the OTDR Trace Batch Editor icon. This 
application allows editing all or selected properties in multiple trace files in the open folder.

OTDR Trace Batch Editor
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Menu Bar
The Menu Bar contains File, Edit, Tools, Events, View, and Help menus. When a menu is selected, it displays a list of 
commands indicating functions that can be performed on selected files.

File Menu

Table below gives a summary of the available File Menu commands and their associated functions.

Command Use to perform the following Function
Open... Access the Results Explorer. Depending on the user preference setting (Edit 

>Preferences > Single-Wavelength or Multi-Wavelength), open a single 
trace file or a multiple trace file.

Login to FlexReporter-Cloud /
Logout of FlexReporter-Cloud

Login to FlexReporter Cloud / Logout of FlexReporter Cloud

Reset FlexReporter-Cloud Password Reset FlexReporter Cloud Password
Change Organization... This menu option allows changing to another organization (if applicable)

Download data from FlexReporter-
Cloud...

Access FlexReporter Cloud Wizard to download 

Import Results... Download test data from an instrument.
Import OFL Results... Download test data from an OFL250 or OFL280 (non-FlexTester).

Export Job to File... Export the selected Job to a zip file.
Backup Data... To have a restoration point, create a non-visible backup copy of your data 

before editing:
	• Navigate the desired Job /Route/Cable
	• Click OK to display the Backup Description window
	• Add a clear comment on backed up data to be able to identify it during 
restoration

Restore Data... Restore previously backed up data to a visible folder. Use comments to 
identify data for restoration (see “How To Restore Data” on page 23 for 
details).

Exit Close opened trace files and exit FlexReports.

Edit Menu

The Edit menu allows the user to set up Preferences. See section “Edit Menu” on page 12.

Tools Menu

This menu provides access to the Home screen menus. See section “Tools Menu” on page 24 .

Help Menu

This menu provides access to the following: AFL web site, AFL Test and Inspection web site, AFL Software updates 
on the web, License Information, “About FlexReports” screen. See section “Help Menu” on page 13.

Toolbar
Toolbar on the Batch Editor provides access to File Explorer and Results / Reports screen.

Command Function
Open Locate and open the desired trace file
Results/Reports Open the Results/Reports Application

OTDR Trace Batch Editor
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Auto Events Editor

Features of the Auto Events Editor are summarized in the table below.

Ref Feature Description
 1 Recalculate Auto Events 

check box
Select/deselect this check box to enable/disable the recalculation process.

 2 Event Thresholds properties  
- editable fields

The Event Thresholds default values may be edited when the Defaults check 
box is deselected.

 3 Test data - informative only These fields display Backscatter Coefficient BC and Group Index of Refraction 
GIR.

 4 Default Thresholds 
properties check box

Select/deselect this check box to enable/disable the default values for Event 
Thresholds. 

 5 Launch Cable user-defined 
fields

This section contains fields where the user may either select one of the 
predefined launch cable option (None, Noyes 50 m/500 m/1 km) or enter the 
preferred length (User option).

 6 Process Traces button Click on this button to start the batch editing process.

Changes to Launch Cable settings may be edited and reapplied to multiple files using the Batch Editor.

1.	 In the directories and files window, select results to which you wish to apply modified Launch Cable setting.

2.	 Select one of the following:

	• [Add File >>]:  Adds individually 
selected files to the Files to Edit 
window.

	• [Add End1 -> End2 Files >>]: Adds all 
End1 -> End 2 files to the “Files to 
Edit:” window.

	• [Add End2 -> End1 Files >>]: Adds 
all End2 -> End1 files to the “Files to 
Edit:” window.

3.	 Check the “Recalculate Pass/Fail” box.

4.	 Un-check “Defaults” box .

5.	 Edit the Launch Cable length, set to the 
desired value.

6.	 Click “Process Traces” to apply the 
edited Launch Cable length to the 
selected “Files to Edit”.

OTDR Trace Batch Editor
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Features of the Pass/Fail Editor screen are summarized in the table below.

Ref Feature Description
 1 Recalculate Pass/Fail check box Select/deselect this check box to enable/disable the recalculation process.

 2 Thresholds check box Select a check box to enable the corresponding Thresholds editable field.

 3 Thresholds editable fields These fields allow editing Thresholds parameters to the allowed limits as 
needed.

 4 Process Traces button Click on this button to start the batch editing process.

Thresholds Allowed Limits

Event Threshold Min Value (dB) Default Value (dB) Max Value (dB)
Event Pass Thresholds
Loss, Reflective Event 0.05 0.75 3.00
Loss, Non-reflective Event 0.05 0.30 3.00
Reflectance: 1310, 1550 nm -65.0 -35.0 -20.0
Reflectance: 850, 1300 nm -45.0 -22.0 -15.0
Event Marginal Thresholds
Loss, Reflective Event 0.00 0.00 1.00
Reflectance 0.00 -5.00 -10.0
Link Threshold Min Value (dB) Default Value (dB) Max Value (dB)
Link Pass Thresholds
Loss: 850, 1300, 1310, 1550 nm 0.00 0.00 35.0
ORL: 850, 1300, 1310, 1550 nm 20.0 25.0 65.0
Link Marginal Thresholds
Loss: 850, 1300, 1310, 1550 nm 0.00 0.00 5.00
ORL: 850, 1300, 1310, 1550 nm 0.00 0.00 10.0

Adjust Pass/Fail Editor
This editor allows the user to edit Pass/Fail event and link Thresholds to the allowed limits as needed.

OTDR Trace Batch Editor
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Edit & Reapply Event Pass/Fail Limits

Pass/Fail limits may be edited and reapplied to multiple files using the Batch Editor.

1.	 In the directories and files window, select results to which you wish to apply modified limits.

2.	 Select one of the following:

	• [Add File >>]:  Adds individually selected files to the Files to Edit window.

	• [Add End1 -> End2 Files >>]: Adds all End1 -> End 2 files to the “Files to Edit:” window.

	• [Add End2 -> End1 Files >>]: Adds all End2 -> End1 files to the “Files to Edit:” window.

3.	 Check the “Recalculate Pass/Fail” box.

4.	 Check “Event Pass Thresholds” box for each Wavelength.

5.	 Edit the Event Pass thresholds (Loss & Reflectance).

6.	 Click Process Traces to apply the edited Pass/Fail limits to the selected files in the  “Files to Edit” window.

3

6

OTDR Trace Batch Editor
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Features of the Cursor Editor are summarized in the table below.

Ref Feature Description
1 Update Cursors check box Select/deselect this check box to enable/disable updates.
2 Zoom adjuster Allows changing horizontal/vertical magnification around the active cursor.
3 Cursors data This field displays A and B cursor locations and distance from A to B.
4 Process Traces button Click on this button to start the batch editing process.

Cursor Editor

OTDR Trace Batch Editor

Trace graph A & B cursors Click to toggle between A and B cursors
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Trace Information Editor

Features of the Trace Information Editor are summarized in the table below.

Ref Feature Description
 1 Update Trace Information check box Select/deselect this check box to enable/disable updates.

 2 Trace properties check boxes Select a check box to activate the corresponding editable text field.

 3 Properties editable fields This section contains text fields where the user may enter all 
information needed to identify traces.

 4 Process Traces button Click on this button to start the batch editing process.

OTDR Trace Batch Editor
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Click to clear all the text fields and check boxes
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Batch Editing OTDR Traces
1.	 Access the OTDR Trace Batch Editor application. 

2.	 Navigate to the desired Job.

3.	 All trace files in the open folder will be displayed in the Trace Selector window.

4.	 From the displayed list, add the desired traces to the “Files to Edit” list, which will be displayed in the Files to 
Edit window. Use the Add File, Add END100 –>END200 Files>>, or Add END200 –>END10000 Files>> buttons for 
adding trace files.

To add trace files in the current folder to the batch edit list individually:

	• Double-click the desired trace name listed in the Folders/Files window. The trace name added to the batch 
edit list will appear in the Files to Edit window.

	• Or, click on the desired trace name listed in the Folders/Files window, then click on the Add File button. The 
trace name added to the batch edit list will appear in the Files to Edit window.

To add a group of traces in the current folder to the batch edit list:

	• Click on the first trace to be added to highlight it.

	• Hold the Shift key to scroll down to the last trace you wish to add to the batch edit list.

	• Click on the Add File button. The trace names of the selected files will appear in the Files to Edit window.

5.	 If you need to remove trace files from the batch edit list displayed in the Files to Edit window, use the Remove 
File or Remove All Files buttons.

	 To remove trace files from the batch edit list individually:

	• Double-click the desired trace name displayed in the Files to Edit window. The trace name listed in the Files to 
Edit window will be removed.

	• Or, click on the desired trace name displayed in the Files to Edit window, then click on the Remove File button. 
The trace name listed in the Files to Edit window will be removed.

	 To remove a group of traces from the batch edit list:

	• Click on the desired traces to be removed to highlight.

	• Click on the Remove File button. The trace names listed in the Files to Edit window will be removed.	

	 To remove all trace files from the batch list:

	• Click on the Remove All Files button. All trace names listed in the Files to Edit window will be removed.

6.	 Use Auto Events, Adjust Pass/Fail, Cursors, and Trace Information Editors as needed.

7.	 Click on the Process Traces button to complete updates/changes.

OTDR Trace Batch Editor



OLTS Viewer/Editor Application
Using the OLTS Viewer/Editor users can verify Auto-test results from the AFL OTDRs and OLTS Certifiers. Results can 
be compared to current industry standards, applications or user values. As standards evolve or network demands 
increase users can apply more stringent rules to be sure tested fibres will meet the requirements. 

Opening Test Results with OLTS Viewer/Editor
The OLTS Viewer/Editor application may be accessed in several ways:

	• From the Home screen by clicking on the OLTS Viewer/Editor icon.

	• From the Results Explorer by selecting a fiber and with a fiber selected double-clicking on the AT icon.

	• From the Results Explorer by selecting a fiber and with a fiber selected, displaying the Open Viewer submenu 
and selecting the OLTS Viewer/Editor.

This application allows reviewing loss measurements and certification test results and selecting standards and 
applications to apply to certification test results.

OLTS Viewer / Editor



OLTS Viewer/Editor Screen Features

Ref Feature Description
 1 Menu bar Displays the available drop down menus.
 2 Toolbar Contains several icons for quick access to menu commands.

Click on an icon to execute the associated command.
 3 Applications tabs Click on a tab to display the corresponding application window.
 4 Results button “On mouse over” the Results button, the Results window is displayed and “on mouse 

out” the Results window is auto-hidden.
 5 Results window The Results window displays folders and files hierarchy and is used to navigate saved 

test results. To disable/enable the “auto hide” functionality, click the Auto Hide icon 

 located in the right top corner of the Results window.
 6 Cables Info window Contains informative fields: Job/Route/Cable name, fiber number and direction.
 7 File Info window Contains both the editable and informative fields.

Editable fields allow editing/adding Customer, Contractor, and Operators’ ID and 
add comments. Informative fields display test equipment Model numbers, Software 
version, and tested fiber info.

 8 Standards User may select and apply Cabling Standards and Application Standards.

 9 Tests Results Depending on the selected Cabling Standards, User Rule, and Application Standards, 
this area displays certification test results with Pass/Fail by fiber number, wavelength 
and direction, measured Loss and Length.

 10 Details window Displays the details of the selected standard, maximum loss, and maximum length. 
	• Select check box of Cabling and/or Application standard.
	• Click on  button to expand Results of the desired Fiber - loss values, direction of 
test, and Pass/Fail by wavelength 

	• Click on the desired check box /  to display Details of the selected Standard (max 
loss and length).

OLTS Viewer / Editor
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Menu Bar
The Menu Bar contains File, Edit, Tools, View, and Help menus. When a menu is selected, it displays a list of commands 
indicating functions that can be performed on selected files.

File Menu

The File drop down menu contains several commands as follows.

Command Function
Open Access the Results Explorer and navigate the desired test results file.
Save Save a file that already exists with its original name. 
Save As... Save an existing file under a new name and preserve the original file.
Print OLTS Report Print the currently displayed OLTS report.
Close Close the open cable results and clear the OLTS Viewer. 
Login to FlexReporter-
Cloud /
Logout of 
FlexReporter-Cloud

Login to FlexReporter Cloud / Logout of FlexReporter Cloud

Reset FlexReporter-
Cloud Password

Reset FlexReporter Cloud Password

Change Organization... This menu option allows changing to another organization (if applicable)
Import Results... Download test data from an instrument.
Import OFL Results... Download test data from an OFL250 or OFL280 (non-FlexTester).
Export Job to File... Export the selected Job to a zip file.
Backup Data... To have a restoration point, create a non-visible backup copy of a test data:

- Navigate the desired Job /Route/Cable 
- click OK to display the Backup Description window 
- add a comment on backed up data to be able to identify it during restoration

Restore Data... Restore previously backed up data to a visible folder. 
Exit Close opened files and exit FlexReports.

To Restore Data

See section “How To Restore Data” on page 23.

Edit Menu

The Edit menu allows the user to edit existing or create new User Rules, edit Fiber Under Test data and configure 
Preferences.

Edit Fiber Under Test

OLTS Viewer / Editor

These fields allow the user to define fiber under test (FUT) parameters: 
length, number of splices, and number of connections

These fields allow the user to define connectors type, fiber type, and test 
method



Edit or Create New User Rules

To Configure General Preferences

See section “To Configure General Preferences” on page 12.

Tools Menu

This menu provides access to the Home screen menus. See section “Tools Menu” on page 24.

Help Menu

This menu provides access to the following: AFL web site, AFL Test and Inspection web site, AFL Software updates 
on the web, License Information, “About FlexReports” screen.

See section ”Help Menu” on page 13.

About FlexReports screen

About FlexReports... screen displays FlexReports version number and allows to see included Modules/Versions. For 
details, see section “About FlexReports screen” on page 13.

Toolbar
Toolbar on the Batch Editor provides access to File Explorer and Results / Reports screen.

Command Function
Open Locate and open the desired trace file
Save Save a file that already exists with its original name
Results/Reports Open the Results/Reports Application

OLTS Viewer / Editor

Select Loss Type

Rule name and descriptionClick to create New Rule

Select Rule Type User-definable fields, which allow the 
user to select either MM or SM test 
port and set Pass/Fail criteria

Click to add 
wavelength



Viewing OPM Results in the OLTS Viewer/Editor
OPM test results may be opened in the OLTS Viewer/Editor application, which allows reviewing loss measurements 
by wavelength and direction and selecting standards and applications to apply to certification test results.

To Select Standards and Applications

1.	 Navigate the desired OPM test results and open them with OLTS Viewer/Editor application (see section titled 
“Opening Test Results with OLTS Viewer/Editor” for details).

2.	 Click the Apply Rules button to display the Edit Fiber menu .

3.	 Edit fiber parameters as needed. 

4.	 Click OK.

These fields allow the user to define fiber under test 
(FUT) parameters: length, number of splices, and 
number of connections

These fields allow the user to define connectors type, 
fiber type, and test method
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